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Welcome to KnoxPlans, Version 9.1 

KnoxPlans (aka “ProjectDox”) client tools have been certified to execute on PC operating 
systems up to and including Windows 7 32-bit (Windows 7, 8 & 10) and Internet Explorer 11.   
 
Please note that in order for this application to work you must first complete the following steps 
when you login for the first time.  Since you will be installing software, you must have rights on 
your pc to perform the installation.   
 

Recommended Client Hardware and O/S Specifications 

Uniform specifications on end-user hardware, software capabilities and configuration will have a 
big impact on the end-user experience. We recommend deploying (at most) two types of end-
user hardware with standard configurations. 
 

Client Specifications 

Operating System Windows 10, Windows 8 (64 bit OS), Mac OS 10, iPad, Windows 
Tablet 

Processor Dual Core or Quad Core Processors 2.0 GHz or faster 

Memory 8 GB RAM or more 

Browser Cache  In Internet Explorer, this is 50MB by default and in most browser it can 
be increased to 250MB or up to 1GB  

Graphics Card  Single Monitor Support - Dedicated Graphics Card with Minimum 1GB 
Memory, Dual Monitor Support - Dedicated Graphics Card with 
Minimum 2GB Memory  

Recommended Web 
Browsers  

Internet Explorer 11 (32-bit only), Edge, latest releases of Chrome, 
Safari, and Firefox.  

Display 22” or larger with at least 1920 x 1080 screen resolution  
 
  



Knoxplans for New Users | 2018 
Page 3 

Browser Requirements 

The Matrix below displays the requirements needed for each browser to interact properly with 
the ProjectDox application.   
 Note – Extra steps are required if you use Internet Explorer as shown in the chart below.  If 

you use Chrome, Safari, Edge, or Firefox, these extra steps are not required. 
 
 
 
 
 
 
 
 
 
 

All Browsers - Configure Pop-Up Blockers (Applies to All Browsers) 

ProjectDox uses pop-up windows 
(browser windows with no toolbars). If 
you log in, but no ProjectDox window 
appears, or a warning is received, you 
probably have a pop-up blocker that is 
preventing the main project window 
from opening.  You need to allow ALL 
pop-ups for the ProjectDox site. You 
can do this in one of two ways:  
 
1. Disable pop-up blockers entirely. 
2. Configure blocker to allow pop-ups for specified sites. 
0. 
In the following sections, you will find information that will assist in setting up the allowance of 
pop-ups for several browsers. If after going through the steps you still have difficulty with the 
ProjectDox application, verify your system has no other pop-up blockers installed.  

• Google Search bar is installed, it contains its own pop-up blocker that will need to be 
disabled.  

• Antivirus software can cause similar behavior, review the enforced rules  
• Check system anti-virus logs to see if that software may be blocking the site from 

displaying. If the anti-virus is blocking the installation, add the necessary exceptions.  
 
Pop-Up Blocker Instructions 

• Internet Explorer – see pg 4. 
• Chrome – see pg 5. 
• Firefox – see pg 6. 
• Safari – see pg 7.  
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Configure Pop-Up Blocker in Internet Explorer 

Navigate to Internet Options for your version of Internet Explorer (IE). Instructions below are 
based on IE11.  
 
1. Select the Tools icon in the top right corner.  
2. Choose Internet Options from the dropdown.  
3. Select the Privacy tab and, in the Pop-up Blocker section, click the Settings button.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4. In the Pop-Up Blocker Settings Window, enter 

the Knoxplans site URL.  
5. Click the Add button. 
6. Click to Close the Pop-up Blocker Settings 

window.  
7. Click the OK button for the Internet Option 

window.  
0. 
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Configure Pop-Up Blocker in Google Chrome 

It is recommended that users use the 32-bit version of Chrome; it is known to work better with 
reports in ProjectDox. 
 
 To verify what version of Chrome you are using (32 bit or 64 bit), click on Chrome’s menu 

icon   and select About Google Chrome. If it is 64 bit, it will say so in parentheses 
after the version number.   

 
1. In the top-right corner of Chrome, click the Chrome menu icon .  
2. Select Settings. 
3. Click Advanced, found at the bottom of the page. 
4. Under Privacy and security, expand the Content settings field. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5. Click Popups, click the Add button under 

the Allow field.  
6. Enter the ProjectDox URL, then click the 

Add button. Close out of Settings when 
finished.  

0. 
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Configure Pop-Up Blocker in Firefox 

1. Click the menu button and select Options. 
2. Click the Content menu, and select the Exceptions button next to the Pop-ups field.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3. Enter the ProjectDox URL in the available field, 

then click Allow.   
 
 
 
 
 
 
 
 
 
4. Click the Save Changes button. 
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Configure Pop-Up Blocker in Safari 

1. Select Safari->Preferences, then click Security.   
 
 
 
 
 
 
 
 
 
2. In the Web Content and Internet plug-ins 

sections, deselect the Block pop-up 
windows checkbox.   

 
 
 
 
 
 
3. Close the window.   
0. 
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Internet Explorer Requirements Only 

Adding Knoxplans to Your Trusted Sites (Internet Explorer only) 

ProjectDox loads ActiveX controls 
onto your pc so that you can view 
drawings and markups.  Before the 
controls can be loaded, the Knoxplans 
Site (www.knoxplans.org) must be 
added to your list of Trusted Sites  in 
your Internet Explorer security 
settings.   

1. Select the Tools icon in the top right corner of the browser.   
2. Choose Internet Options from the dropdown. 
3. In the Security tab, click Trusted sites to highlight, then click the Sites button.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4. Type https://www.knoxplans.org in the top field and then click Add. 
5. Click Close when finished. 
6. Click OK to exit the Internet Options window. 
0. 
 
 
 
  

http://www.knoxplans.org/
https://www.knoxplans.org/
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Disabling the UAC (Internet Explorer only) 

Disabling of the UAC control should be 
discussed with your network 
administrator prior to making changes 
to your system if applicable. In all 
cases, after the installation is complete 
and each of the actions have been 
performed once (uploading files, 
viewing files, downloading files, and 
viewing help, as applicable) the UAC control can be returned to the former setting.  
 
Windows 8 & 10: 
1. Select the Windows key on your keyboard  
2. When the menu appears, start typing “Change User Account 

Settings.” It will initiate a search.  
 

3. Select the following from the search results.  
 
 
 
 
 
 
 
 
 
 
 
4. Click and drag the slide control to Never Notify.  
5. Click OK and restart your system. This must be done 

for the UAC changes to take effect.  
0. 

Note: The system must be restarted for the UAC 
changes to take effect.  
 
Note: The User's permissions level/rights will affect 
how the UAC works.  
 
Note: After successful installation and one time usage 
of the ProjectDox Components, the system’s UAC 
control can be returned to the former setting. A reboot 
will be required for the change to take effect.0.  
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ProjectDox Client Components (Internet Explorer only) 

Sometimes users will encounter errors 
or issues as a result of incomplete 
installation of the client components.  
This is often caused by permissions 
issues.  The instructions in the next 
section (B.) proved useful in resolving 
the security/permissions issues and 
getting a successful installation.   
 
 Note – The account executing these steps will need administrative privileges on the 

computer. 
 
A. Installation of ProjectDox Program (Internet Explorer only) 
ProjectDox requires the installation of ActiveX controls to be able to perform certain actions: 
Uploading Files, Downloading Files, Viewing Files, and Viewing Help Information.  There are 
two ways users can install the controls:  
 

A. The link to an MSI file for installing the ActiveX controls is available from the login screen.  
B. If the user’s network requires administrative access to download ActiveX controls, the 

user will NOT be prompted, nor will the MSI on the login screen install. The user will need 
to contact their network administrator to get access to download these controls.  

 
1. Install ProjectDox components necessary for the application. 

a. In your Internet Explorer window, go to the following site: www.knoxplans.org.   
b. A login screen will open.  Click on the Install ProjectDox Components link (, below) at 

the bottom left corner of the screen. 
c. The application will install the necessary components for the system to function correctly.  

This may take five minutes. 
 .Note – If using the MSI from the login page, the user can accept the defaults to run the MSI 
and install the controls.  If not using the MSI, then after logging in to the site, the user will be 
prompted by the browser to install the ActiveX control (yellow bar at top of the screen or at the 
bottom of the screen, depending on system version) when attempting to view help information, 
or uploading, downloading or viewing files. 
 
 You may also want to create a Desktop shortcut to www. knoxplans.org (ref link at ) 

and add it to your favorites (ref link at ).   
 
 
  

http://www.knoxplans.org/
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B. Installation of Viewer Component (Internet Explorer only) 
If not installing from the login page, and using the prompts when opening a file for the first time, 
the below screen will display with a white background instead of the selected file.  
 

• Look for the ActiveX tool bar at the 
top or bottom (Depends on 
operating system) of the page.  

• Click Allow to allow the installation 
of the BravaClientX Module. 

 
 
 
 
 
 
 
 
 
 
 

• After successful installation, the file can be selected again to be viewed.  
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Enabling the UAC (Internet Explorer Only) 

After the installation is complete and 
each of the actions have been 
performed once (uploading files, 
viewing files, downloading files, and 
viewing help, as applicable) the UAC 
control can be returned to the former 
setting. A reboot will be required for the 
change to take effect. 
 
Windows 8 & 10: 
1. Select the Windows key on your keyboard  
2. When the menu appears, start typing “Change User Account Settings.” It will initiate a 

search.  
3. Select the following from the search results: Change User Account Control Settings. 
4. Click and drag the slide control to the Default setting.  
5. Click OK and restart your system. This must be done for the UAC changes to take effect.  
0. 
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Internet Explorer Additional Recommended Steps 

Internet Explorer 11 Only - Clear Temporary Files 
After installing the necessary components, you will need to clear the temporary files from the 
browser history.   
1. Select Tools (via the Gear Icon) > 

Safety > Delete browsing 
history… 

 
 
 
 
 
 
 
 
 
 
 
 
2. Make sure to uncheck Preserve Favorites website 

data and check both Temporary Internet Files and 
Cookies then click Delete. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3. You will get a confirmation at the bottom of the window once it has successfully cleared your 

cache and cookies. 
0. 
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Internet Explorer 11 Only – Remove from Compatibility View Settings 
1. Open Internet Explorer (IE 11). 
2. Press the Alt key on your keyboard, this will make a menu bar appear 
3. Click on the Tools menu tab 
4. Select the Compatibility View settings option 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5. In IE 11, the “Display all websites in 

Compatibility View" option is not available 
6. Uncheck the "Display intranet sites in 

Compatibility View" option. 
7. Click Close. 
0. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Once you have completed the these steps, you are ready to login to the system 
for the first time. 
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Login & Change Password 

1. Click the Login to ProjectDox link at the bottom of the invitation email you received. 
 
 This email has the user login and temporary password that you will need to login.  Future 

emails will not contain a temporary password.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. The login window will open.  In the E-mail field, type the User Login information as listed in 

your invitation email.   
3. In the Password field, type the temporary password as listed in the same email.  You will 

be given an opportunity to change it. 
4. Click Login. 
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5. This will take you to the User Profile screen.  (Required fields display with colored highlight.)   
6. In the Change Password section, enter your new password in the first two fields (Ref. , 

below).   
7. In the Password Reset Question & Answer section, enter a security question and answer 

so that your password can be reset if necessary (Ref. , below).   
 
 Your password must be between 8-12 characters with at least 1 upper case letter, 1 

lower case letter, and 1 number. Special characters are not allowed.  
 
8. Enter remaining contact information as applicable on the screen.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
9. You can access this screen again at any time by clicking the Profile button in the main 

ProjectDox button bar.   
10. Click Save when you are finished. 
0. 
 To go to the home page, click Projects button at the top right of the screen.   
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Testing ProjectDox Components 

1. Locate your project and open a project drawing. 
2. If there are any markups, open Markups on a project drawing to see if you can view them. 
0. 
 
 

Troubleshooting – How to Uninstall ProjectDox Client Components 

Perform a clean uninstall and reinstall of the client components by following these steps: 
 
Remove ALL ProjectDox components on the client 
1. Check for presence of the program, and remove if found, using either steps A. or B. 

depending on version of operating system you are using: 
a. VISTA, Windows 7 - Using Control Panel (in classic view) -> Program Features, if 

ProjectDox Components is listed then REMOVE. 
b. XP – Using Control Panel -> Add/Remove Programs, if ProjectDox Components is 

listed then REMOVE. 
2. In Internet Explorer (Internet Options->Browser History->Settings->View Objects - 

remove anything Brava, ProjectDox, or Xupload).  
3. After the above is completed, delete these directories and their contents: IGC  (in Windows 

Vista or 7, do a search for the filename IGC to locate, then delete) 
a. In XP Documents and Settings->User Account->IGC. 
b. In XP  Program Files->Avolve->Components). 

 . 
 

Re-Install ProjectDox Client Components 

1. Reinstall the ProjectDox components by clicking on the link on the login page..(Again, if Vista 
or Windows 7, UAC must be OFF for this to work.) 

2. Once the components are installed, you can turn UAC back on. 
0. 
 
 
 
NOTE: If you have any problems with software installation, send email to 
knoxplans@knoxvilletn.gov for further instructions. 
 
 
 
 

mailto:knoxplans@knoxvilletn.gov


Knoxplans – New Features 8.1 to 9.1 

Login Screen 
The login screen is slightly different for version 9.1.  There is a new link near the bottom of the 
screen that will open the New User Guide.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Home Screen 
Home page has a different look and feel.  All of the projects are located on the Project tab. 
When a user logs in, this will be the first page displayed. 
 

 
  



Search 
Projects can be searched for on the Home screen using a search field for each column.  Enter 
the search term you want.  The list will automatically sort based on what is entered. 
 
 
 
 
 
 
 
 
 

Home Page Navigation 

Old Buttons 
 
 
 
 

New Buttons 
 

In-Project Navigation 

Old Buttons 
 
 
 
 
 

New Buttons 
 
 
 
 
 
 



Button Name Changes 
 
 
 
 
 
 
 

Discussion Topic 
The Notes feature is now called Discussion Topics.  Use this feature to add a comment to 
the project or to` send an email to any person on the project.  Click the Notepad icon to 
access Discussion Topics. 
 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

File Uploader 
The new HTML5 Uploader replaces Silverlight as a way to upload files and drawings to the 
project.  This Uploader window opens every time the Upload Files button is pressed. 
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